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Crime and Punishment Test Generator continues our test generator series that
will allow teachers to create and store tests based on classical literary works and
topics that teachers will use as part of their class curriculum. More importantly,
however, it will allow teachers to create their test questions once, and then give
the teachers the power to instantly generate random, sequential, or a selected
multitude of tests based on the original questions devised. This is extremely
helpful when teachers have a group of classes covering the same subject area
and tests are given to each class — one following the other.

In real time testing | have found that when similar classes take tests sequentially
throughout the day (or on alternate days), some students have a tendency to
consult with students who have previously taken the test. This wouldn’t be so
horrible if they were really trying to learn about the subject from the knowledge
they acquire, but many of them simply want a rote summary of the information —
answers or questions memorized in sequence -- so they can simply fill in the
blanks, regardless of what they should have learned.

| often felt that it would be a boon to our testing environment if teachers could
generate different versions of the same test, without a lot of work. For example,
it would be helpful if we could take a twenty or thirty question test and quickly put
together four or five variations of this test. Each test would be the same content
for each class but with questions arranged in different orders.

| tried this by hand for a while when | was teaching, and it was amazing how
many students | caught with red faces, when they ultimately realized that the test
wasn’t exactly like the one their friends took earlier in the day or yesterday. On a
multiple choice test, for example, some students (in a misguided attempt at
helping their mentally challenged buddies) memorized the sequence of questions
and answers. When the recipients tried using the same sequence of answers
(without even reading the questions) they were stunned at the terrible grades
they received. Hopefully they learned a lesson.

Well, generating a group of tests for the myriad of topics | was covering became
quite a burden, so | decided it would be handy if | had a computer program in
which | could do the following:

e Create collections of these kinds of questions: fill-in, short answer, multiple
choice, open-ended response



e Save these collections of questions as files that | could edit and reuse in
the future.

e Quickly and easily use the files of questions to generate tests with
questions randomly selected from the entire file.

e Quickly and easily use the files of questions to generate tests with
questions randomly selected from selected ranges of questions from the
entire file.

e Quickly and easily use the files of questions to generate tests with
questions | select from the list of question in the entire file.

e Easily create and regenerate multiple variations of multiple choice tests.

e The program should allow teachers to easily make and generate a variety
of multiple choice tests that can offer random options

e In all of the above cases the program should also provide a neatly
formatted list of answers for each of the questions asked.

Notice that the key words from this list are quickly and easily. Teachers have lots
of work to do, and a lot of this work eats up preparation time. A computer
program that would do this prep work would save a lot of time that could be
better spent on other jobs.

Crime and Punishment Test Generator will do the tasks outlined above. In
addition, you can also format your finished tests the way you want them (you can
even paste graphics into the final test you create); save the generated tests in
named files, for use in the future (although graphics will not be retained); copy
and paste your test information into other documents in your favorite word
processor; search for and insert information in your final tests, and print hard
copies to your printer.

Crime and Punishment Test Generator even includes test editors, so that you
can quickly and easily make up your test data and save it in a format that Crime
and Punishment Test Generator can import and append to the current
database of questions and answers. We have even included a simple search
puzzle word list. This is handy for creating search puzzles based on vocabulary,
characters, key terms, etc. This is opened at the start of the program (explained
below).

Installing Crime and Punishment Test Generator

Installation of Crime and Punishment Test Generator is relatively easy. First of
all be aware that this software only runs on Window PC machines. It will not
work with Mac or other types of operating systems. If you received the
installation on a CD, simply insert the CD in drive on your computer. If you have
autostart set on your computer the CD will start up automatically after a few
moments of initialization.



If the installation does not start automatically, simply open My Computer on your
Windows desktop and double click the CD drive icon to open the CD window.
Then double click the setup.exe file to get the installation started.

In both cases above, read the installation screen to complete installation on your
computer. After installation is complete, store your CD in a safe place for backup
use in the future. You won'’t need it in the drive to run the program.

If you received your installation via download form the internet, save the file to a
new folder you create on your Windows desktop. You will need WinZip installed
on your computer (available as a free download from www.winzip.com) to unpack
Crime and Punishment Test Generator installation. If you already have WinZip
installed, double click the file you downloaded and WinZip will give you
instructions to unpack the installation and documentation files to the same folder.
Once this is completed you will have the same files that would be found on the
CD. Simply double click the setup.exe file and follow the screen directions to
install the program on your Windows machine.

Using Crime and Punishment Test Generator

Once you have installed Crime and Punishment Test Generator on your
Windows PC, you will see a shortcut icon in the Baggetta_Ware Literary Test
Generator folder, on the Windows desktop. Double click this with our mouse
button and a splash screen will appear for a few moments. This will be followed
by the program’s main screen, illustrated here.
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there is a status bar with current information about the file being used. Just
above the text window you will find a format bar, which will allow you to format
text you enter in the text window. This works similar to most word processors.
First you must highlight text in the window before making changes to the font
type, and font size. Most of the time, you will probably not even have a need for
these functions, but they are there if you choose to use them.
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At the top of the screen you will see a menu bar. Here is where you will go for
many of the program’s important functions. Let’s take some time to review the
features of this bar (below it many of the same functions are graphically
represented on a toolbar).

Mews Chr+n The drop-down File menu has the options to start
Open A Test File. .. New, when you want to import or generate a new
B Chries test format. Open A Test File... will allow you to
Save As... open final tests that you have saved. You will only

be able to edit and print these saved tests. Save

and Save As... will allow you to save final

Exdt versions of the tests you create. Print Current
Test will allow you to send the test on display to a

printer you have attached to your computer. Exit is the only legitimate way to

close the program when you are done. Make sure you save any tests you have

created before exiting the program.

Print Current Test  Chrl+P

The drop-down Edit menu allows you to Select
All (contents of the text window). Cut or Copy
Selected Text. Paste Text (in the text window).
Clear Selected Text (from the text window).
Word Wrap text in the text window (This is a
: toggle switch to turn this feature off or on. Itis on
v “Word YWrap OnjOff by default -- checked.). Find Selected Text in
the text window. This feature can be very helpful
in a long test when you want to locate a small
piece of information. These features are grayed out if there is no text in the text
window to be manipulated, as you can see by the illustration here.

Select all Chrla

Make Puzzle The Actions drop-down allows you to Make Puzzles
Clear Text Windows from the default word list (customizable). Clear (all)
Open MC Test Generator text windows. Open the Multiple Choice Test

Qpen MC Test Editor

Qpen Question Editor
Import Your Question List




Generator. Open the Multiple Choice Test Editor. Open Question Editor (for
generating new data files of questions and answers). Import Your Question List
(data files for use in generating new tests).

v Toolbar Onjoff The View drop-down menu offers two features.
These are toggle switches again (checkmark

v Status Bar  OnfOFf indicates they are on. With these you can turn

the Toolbar and Status Bar on and off screen

view.

The Insert drop-down menu allows you to Insert
Date/Time into a selected area of the text window.
Test you generate will have a generic heading on

Insert Date/Time

them.

The Font drop-down menu will allow you to
design the font you want to use in the text
Bold Selected Text Cirl+8 window. You will have to select the text first
[talicize Selected Text  Cirl+] before making a selection from this menu.
Underline Selected Text Crl+U The functions on the toolbar perform these

same actions. Format Font, Bold Selected
Text, Italicize Selected Text, and Underline Selected Text.

Format Font

The Options drop-down offers one option. This is
a toggle switch too, that allows the user to
Preview Font (in the font window) as it will

v Preview Font QnjfOFF

actually look if selected.

about The About drop-down will give the user information
about Baggetta_Ware.

The graphic Toolbar does many of the functions, with a few added features,
shown here.
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The center of the main screen contains the control and test information panel. At
the start of the program this panel shows the current database totals.

The control and test information panel is where you will find information about the
current file of questions available. There are three types of tests: Random Tests,

Sequential Tests (plain or randomized), and Selected Questions Tests. If the

database is divided into categories you will see a “Select Topic...” dropdown list.
Panel shown here miaht be from another test aenerator

Generate Random Test Howr Many Random Questions? (121 Maximum)
Generate Test
Start With ’7 End With # Randomize of Selected
Generate Sequential Test &0 (it 1) Sequential Tests THa Do
| Select Topic Here For Quick Sequential Test j

From this list you can select categories of questions to generate Sequential or
Randomized Sequential tests. Let’s experiment with a sample test included with
the installation. You can view the available categories in the database by
clicking the View Categories button.

Generating Tests
Okay. Now we are ready to generate a test. Let’'s generate three different test

formats. The first test we will create will be a short quiz of five questions only
(the label indicates
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{Randomized Test) Type the number 5 n
(1) [Part VI] Svidrigailov dreams that a what is running around his room and the WlndOW and then
Up and down iz body- click the Generate
(2) [Epilogue] The people afflicted with this new plague considered themselves Random Test bUttOn.

and their ideas unhesitatingly what and everyone else as wrong.

Instantly you will

(3) .[Epill_Jgue] Raskulnikqu had been in prison for how many years before he have a f|Ve queStiOI"I
realized his love for Sonia. QUIZ rand0m|y

(4) [Part V] Luzhin accuses Lebeziatnikov of beating whom. Selected frOm the
collected database.

(5) [Part VIl Dunia shoots at Sivdricailov how manu times. b
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The screen will look like the illustration here.

The interesting feature here is that if you don’t like this combination of questions,
you can just click the Generate Random Test button again to get a different
combination of questions. Also, if you like this combination, but want to type in
additional information or add a graphic to this test you can type in your
information or paste a graphic into the text box. You can also add line spaces to
make more room, if you like. And of course you can use the formatting features
to change other characteristics of the final test. DO NOT add anything, however,
if you plan on using the Generate Random Test button to create another version
of the quiz. Only make changes to the final version you will save or print.

If you scroll down the textbox page, you will find the answers to the questions
you have created for the quiz. These are numbered accordingly. If you plan on
printing from the program, you might want to tap down a few lines (using the
computer Enter key) to make sure that your answers appear on a separate page
for your use as a test key. You wouldn’t want to print these for your students to
use.

Now let’s create, a sequential test, generated with the Generate Sequential
Test button. Let’s say you only want a five question quiz from this file using only
questions 3, 4, 5, 6, and 7 from the file, in that order. To do this first type the
starting question number in the Start With... textbox. The number must be above
0 and below the maximum allowed. We will type a 3 in the box. In the End
With... textbox we’ll type the number of the last question we want and that is the
number 7 question.

After you have done this, click the Generate Sequential Test button to get your
results in the text window. You should get a quiz made up of the five questions
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(Sequential Test)

(1) [Part I] Raskolnikov passes the door of his what on his way downstairs.

{2) [Part I] The drunk in the cart makes fun of Raskolnikovw's German what.

(3) [Part I] Raskolnikow tries to pawn his father's gold what.

(4) [Part I] Raskolnikov wants how many rubles for the watch.

{5) [Part I] The pawnbroker gives Raskolnikov a ruble and a what for the
watch.

Mot Saved Line:1 Col:1 114772008 | 1:50 P 889 Bytes

as they appear in the
original text file

DEeES3 @ B 77U - f == (answers at the
4 Crime and Punishment bottom, also), as
rE K H
. 3 Test Generator |Ilustrafted here.
I You might want
enerate Random Tes How Many Random Questions? (290 Maximum) 5 . .
_____ == | cweeren | | different versions of
éGenerale Sequential Test Sf{:'glgtﬂ? 3 f"-"n::ilg‘;ﬁl 7 r Sequ:ﬁtci’g?i‘;—:sts cg:::i?:: thIS teSt (queStlonS 3
| Select Topic Here For Quick Sequential Test j —_ 7 placed randomly
Fredsys = = as 1-15). You cando
trime and Punishment Test Generator -

this by check marking
the Randomize
Sequential Tests box
next to the End
With... box.

Now, when you click
the Generate

Randomize
b Ssequential Tests



Sequential Test button you will get randomized quizzes of the five questions you

opted for. Pretty neat, right?

Sometimes you might just want to pick the questions from the saved file and use

Crime and Punishment Test Generator
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Check the questions you would like to use in the test.
02 [Part I] The story takes place in what month.
03 [Part 1] Raskolnikov passes the door of his what on his way downstai
04 [Part 1] The drunk in the cart makes fun of Raskolnikov's German wha
05 [Part I] Raskolnikowv tries to pawn his father's gold what.
06 [Part I] Raskolnikov wants how many rubles for the watch.
07 [Part 1] The pawnbroker gives Raskolnikov a ruble and a what for the
08 [Part 1] The pawn brokers name was what.
09 [Fart I] Raskolnikov ordered what at the saloon. w
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them to make up a quiz
or test. Again, using the
same file, let’s create a
quiz of question we
want. We’ll use
questions 2, 5, 6, 7, and
10. To do this we will
use the Selected
Questions button.

When you click the
Selected Questions
button, you will get
another window that will
open on screen. For

Generate A Selected Test |

Crime and
Punishment Test
Generator it will look
like the illustration here.
All of the questions in
your file are listed here

Cancel Test

has a check box placed to
the left of the numbers.

You can select the
questions you want to use
in your selected questions
quiz by clicking the
respective check boxes.
You will be able to scroll
down the window if there
are more questions you
can’t see. When you have
completed your selection,
click the Add Selected
Questions button to place
your selections in the
bottom window. You can
remove question you don’t
want by reversing the
process, using the bottom
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Check the questions you would like to use in the test.

01 [Part I] The story takes place in what Russian city. ~
02 [Part I] The story takes place in what month.

03 [Part I] Raskolnikov passes the door of his what on his way downstai
09 [Part I] Raskolnikov ordered what at the saloon.

10 [Part I] Marmeladov was employed as a government what.

11 [Part I] Raskolnikov's occupation was what.

12 [Part I] Marmeladov's daughter makes her living as a what.

13 [Part I] Prostitutes carried what color ticket.

14 [Part I] Sonia is Marmeladov's what.. v

Add Selected Questions | Remove Questions from Selection |

These questions will be used -- select questions you want to remove
04 [Part I] The drunk in the cart makes fun of Raskolnikov's German what.

05 [Part I] Raskolnikov tries to pawn his father's gold what.
06 [Part I] Raskolnikov wants how many rubles for the watch.
07 [Part I] The pawnbroker gives Raskolnikov a ruble and a what for the watch.

08 [Part I] The pawn brokers name was what.
Cancel Test

Generate A Selected Test




window and then clicking the Remove Questions from Selection button.

If you are happy with the questions you have selected, you can then generate
your quiz by clicking the Generate A Selected Test button, located at the bottom
of the screen. If you change your mind about this test altogether, just click the
Cancel Test button to return to the main screen.

After you generate a test (or while you are working on one), be sure to save your
work using the Save (or Save as...) option on the Menu Bar. If you do this you
will assure yourself that you will have these tests to use or edit in the future.

A word about printing. Crime and Punishment Test Generator is designed
mainly for creating tests and answer keys that teachers can use for in their
classes. You can print from the program, but we suggest that you use the
printout for your use in making copies of the tests you create. You will want to
make sure that the answer key is not included with the test you copy for your
students, and it is generally more economical to use a photocopier to make
duplicates for your class rather than printing an entire class worth of tests from
your printer.

Don’t forget, too, that you can copy the contents of the text window in this
program and paste the contents into a more elaborate word processor for printing
or formatting.

Generating Search Puzzles

@ Crime and Punishment Test Generator
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ﬁ Crime and Punishment Test Generator

the .wds extender at the end, and the file must be placed in the program
directory. The list contains words from which the default search puzzle will be
constructed. (No more than 35 words are allowed.)

You can create your own DefaultWordList.wds file and save it to the directory
(overwriting the old one), using your own list of words or other data. Simply use
Microsoft Notepad, which comes with Windows, to create the list. Type one entry
per line and then tap the Enter key to move down a line. The program will only
accept 35 entries (you can have less) from which to make puzzles. Save your
file when you are done. If the .wds file is removed from the directory you will get
an error at the start of the program. To fix this simply create a .wds file and save
it to the program directory.

To generate a search puzzle click the Make Puzzle option on the Actions drop-
down menu. This will open the puzzle window.

The puzzle screen will be blank when you first enter it. Click the Show Puzzle
button and you will get the answer pattern created by the program for the default
list of words. If you don'’t like the structure of the puzzle answers, click the
Revise Puzzle button to get a different version, until you are satisfied.

You can take a look at the default list by clicking the Show Word List button at
the bottom of

@] the screen.
4 You will get a
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Generate Puzzle button to construct the final puzzle. Here we show the finished
puzzle and the word list on display.

The final puzzle can be printed from the program or it can be copied and pasted
into a word processor for final printing.

To get to the print preview screen, click the Print Puzzle button.

You can' see the
Complete _page In the Crime and Punishment Test Generator Word Puzzle ~
preview window
Try to find the hidden words in this puzzle. They
UnleSS yOU ScrO” might be forward, backward, up or down. Good luck.
dQV\C(naT?tehpL{[Zﬂe]'cs EZJLAQBNSLHNZCYZXAJDOQQ
EGAILOFBQPFQLCGBTME?Z
printed a eopq EZUQDNCONFLAGRATIONIJ
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Close button when
you are finished.

Making Question and Answer Files To Import Into
Crime and Punishment Test Generator

You can enhance the power of Crime and Punishment Test Generator by
creating additional question files that you can append to the built in database.
They are easy to create and will give you a larger base to generate from.

Questions you originate can be just about any type. Here are some typical
formats:

e Simple fill-in questions. This can be a statement with a blank line that
requires the students to answer with a word or phrase to complete it. It
doesn’t necessarily have to be in the form of a question.



e Multiple choice. The question or statement is presented, followed by three
or four possible choices as answers.

e Short Answer. The question or statement is presented and students must
provide an appropriate short answer.

e Vocabulary. A definition is given that requires a studied word, or vice
versa.

e Problems. A problem is offered and the solution must be given by the
students.

e Open Ended Question. An idea is offered and students must respond with
their solutions. Your acceptable answers might just be suggestions.

When planning the question and answer files you will be using, keep in mind the
following set up format.

You will need a question.
You will need an answer for the question.

There are two ways to make the original files used by Crime and Punishment
Test Generator. You can make them manually by using any standard text editor
or word processor that can save files in text format. You can also make them by
using our handy Question Editor that is built into the program menu, under
Actions.

Using A Text Editor or Word Processor

If you create your question and answer file using a text editor (Microsoft Notepad,
for example), open a New document and set Word Wrap on. Type your
information using the following format exactly:

On the first line type the title of your question answer file

On the second line type the number of questions you will have in the file
On the next line type the first question

On the next line type the first answer

On the next line type the second question

On the next line type the second answer

Continue this pattern until you have typed all of your questions and answers.
When you are finished, Save the file as a text file (this is especially important if
you are using a word processor which usually saves as a document file). Some
text editors automatically attach a .txt extender at the end of the file. If this is the
case, after you save your file, locate it using My Computer or Explore and use
the Rename option of Windows to change the extender from .txt to .tga. If you
don’t have this extender on the end of the file name it will not be recognized by
the program



If you want to see how the actual files are constructed open the Sample Generic
Questions.tga file that accompanies the program installation in your text editor

and take a look at it.

Using the Question Editor in Crime and Punishment Test Generator
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File: Mame
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We have made
question and
answer file
creation a bit
easier with the
inclusion of the
Question
Editor. You can
get to this editor
through the
program Menu
Bar. Click
Actions and
then click Open
Question
Editor. The
blank editor will
open on screen

and look like the
illustration here.

This add-in program makes file construction easy because you will only be typing
one question and answer at a time. If you want to open our sample file or any
other file you create, use the Open File button. To start a new file, click the New
File button. First you might wan to click on the File Name textbox to type in the
title of your question answer file. Make the name simple and recognizable. After
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You can use this_editor to create

Test Generator
Question Editor
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your test generator program. Use the
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Save File | |

Question

‘The author of 'Oliver Twist' was who? Herman Melville, Nathanial Haw

Answer

Charles Dickens

File: Wame
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This Is A Sample File Not Necessarily For This Program

Question #7

you put in the name
you can start creating
the questions and
answers for your file.
Type a question in the
Question textbox and
then tab down to the
Answer textbox to type
the correct or
suggested answer for
this question. Click the
scroll bar at the bottom
of the screen to go to
the next question.



Continue typing questions and answers until you are done, and then click the
Save File button to save your question and answer file. We suggest that you
make a new folder with subfolders somewhere on your computer that will house
all of your question and answer files.

If you decide not to use the file you can use Abort Work to stop work on a file
and simply Quit to return to Crime and Punishment Test Generator.

APPENDIX I: Multiple Choice Test Generator

Crime and Punishment Test Generator offers the option to create multiple
choice tests. These tests are built differently from the regular questions imported
into the generator so we have a separate add-on program to do the work and
also a special multiple choice editor to help you prepare your lists of questions
with ease.

Before using the Multiple Choice Test Maker you will want to create a list of
questions and answers. Once you have this list of material you can use the
Multiple Choice Test Maker to create many variations on the list. So let’s take
a look at the Editor first, to see how it works.

To get to the editor, start Crime and Punishment Test Generator and click the
Actions menu at the top of the screen. On the drop down list, click Open MC
Test Editor. It is the fourth option on the dropdown list. You should see the editor
appear on screen and it looks like the image here.

Crime and Punishment Test Generator Multiple Choice Test Editor Th 1S lOOkS S mllar

to the regular test

"y Crime and Punishment editor, but it is
: = Test Generator refined to accept
M uI.E;‘Fdnﬂ.‘_m crcate your Multiple Choice Test Editor multiple choice
iR T | quesions and
pj:::sible cqhoices. The first = Guit pOSSlble answers.

choice should be the cormrect |
answer.

Question

| At the top of the

First Answer [This should be the CORRECT answer] Third Answer Choice screen Is the
| | control panel

which will allow

|Second Answer Choice |Fourlh Answer Choice you to start a NEW
FILE, OPEN FILE,

[l B SAVE FILE,

Enter TITLE of this project —>3>> | ABORT FILE, and

QUIT.

You can see that
there are boxes to type your question and four possible answers — the first
answer will always be the correct answer. This is important; otherwise you




will not get correct results in the answer keys.

At the bottom left there is a scroll bar which you will use to move back and forth
through the questions as you create them, and at the bottom right is a box where
you should enter the title for your test. Keep this reasonably short. Here’s what
the editor looks like when you have completed work on a question or series of

questions and answers.

Crime and Punishment Test Generator Multiple Choice Test Editor
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IRodya INakita
Second Answer Choice Fourth Answer Choice
van INikov

‘ »| Question#1

Enter TITLE of thiz project -->3>3>3>

|Crime and Punishment Multiple Choice Test

When you have
complete all of
the questions
and answers you
want in this file,
be sure to SAVE
your file with a
unique name that
you will
recognize and in
a location on
your hard drive
or network you
will have access
to. The file will
be automatically
appended with
an .mct extender.

Make sure you have typed only the number of questions and answers you want

to use in the test variations.

Crime and Punishment Test Generator

Files

Use QUIT to close the

Multiple Choice Test Editor | 4, CTrime and Punishment
Test Generator

when you are through
creating lists of questions
and answers.
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choice ﬁle Created that you Open a test database file. .

want to use, you can
create multiple variations
on this database using the
Multiple Choice Test
Generator. Here’s how
you access it. On the
Academic Test Generator
menu, click the Action item
again and from the
dropdown menu this time




select Open MC Test Generator. This is the third item on the dropdown menu.
The test generator opens and looks like the image here.

Before you can use the Multiple Choice Test Generator (MC), you must open the
file you just created, or some other that you have
stored away. You can easily do this by clicking the
Files menu at the top of the screen and from the
dropdown list select Open Multiple Choice

Close With Save Database. Do not try to open other than an .mct file.

They will not work. If you have a correct file the

menu will close and a red message will appear on screen indicating that your file
is now ready to use.

Open Multiple Choice Database

Close With MO Save

At the top of the screen you will notice a control panel with some large buttons
and some option dots.

Sequential Q. and Ans. Random Q. and Ans. Sequential Q. /Random Ans. Format Options
* Word Answers {* Word Anzwers f* Word Anzwers - Answers Presented
i Letter Answers {— Letter Answers { Letter Answers Horizontally
Sequential Questions Random Questions and Sequential Questions Anszwers Prezented
and Answers Answers Random Answers Wertically

The control panel has three separate additional panels and each will determine
how your variation of the questions and answers will be set up. In each separate
panel you have the choice of having your answer key displayed as Word
Answers or Letter Answers. Each question will automatically be labeled as A., B.
C., and D., followed by respective answer choices. If you click the Word Answer
dot (the default for each of the panels at the start), your answer keys will be
displayed as a list of words or phrases, each numbered according to the question
it pertains to. If you choose Letter Answer, then the answer key will only show
the correct letter that should have been chosen to answer the question.

To quickly generate a test or worksheet from any of the panels, click the
corresponding large button for that panel. Here’s what you will get for results
using each button:

Sequential and Answers will give you a test that uses the exact order you
entered the questions and answers in the file you created. But every time you
click the button the order of the questions will vary. It would be most effective to
produce an answer sheet using Word Answers rather than Letter Answers for
this option.

Random Questions and Answers will give you a test that changes the order of
each question in the list and a different order for the answers.



Sequential Questions and Random Answers will give you a test that keeps the
original order of the questions, but changes the order of the answers for each

question.

Format Options will allow you to generate answer options horizontally or

vertically.
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From here you can now modify the file any way you want, even adding graphics,
and then print, using the Print option found on the File menu.

If you want to use any of the regular functions of the program you will have to
clear the Multiple Choice test first, using the New option on the File menu.

PROGRAM UPDATES and SUPPORT

As with all Baggetta_Ware products we have tried to keep this software simple to
use and yet functional enough to make it useful. We hope to improve the
program yet and welcome any suggestions you might have. You can forward
them to us through our web page or directly via email at the following address:
baggetta@baggetta.com.

If you encounter any problems with the program, we will try to help you resolve
them as quickly as possible. Please send us email at the above address
detailing the problem. Be sure to include information about your computer
system makeup and any error messages you might encounter. Baggetta Ware
and affiliates are not responsible for any damage caused by unforeseen bugs or
issues to other software and hardware you may be using. Do not use this
software if you cannot agree to these terms.

Copyright -- Questions and answers for our test generators have been devised
by Baggetta Ware and are not to be used for resale or redistribution in any form
without the expressed permission of Baggetta Ware.

You can register your purchase on line at our site www.baggetta.com

A. Baggetta
Baggetta_Ware



